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Chapter 1.0:  Introduction 
 
1.1 Purpose and Scope 
This Pre-Ordering and Ordering Guide is intended to provide the D/CLEC 
(Data/Competitive Local Exchange Carrier) facility description and general 
information specific to processing a request for the service offering described 
herein. This is an updated version release.  

For the remainder of this document, Loop Qualification System will be referred to 
as LQS.  A detailed description of this facility offering will be provided in Chapter 
3.0, Overview, of this document.  The Local Support Manager (LSM) should be 
contacted regarding questions about the information contained herein.    

1.2 Disclaimer Statement 
 
The information contained in this document is subject to change.  BellSouth will provide 
notification of changes through the D/CLEC Notification Process.  This guide will be 
maintained until such time that its content is incorporated into the BellSouth Business Rules – 
Local Ordering (BBR-LO).  The BBR-LO is found at: 
 

http://www.interconnection.bellsouth.com/guides/html/leo.html
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Chapter 1.0:  Introduction (continued) 
 
1.3 Version History/Control 
 
Any future modifications, enhancements, and/or improvements that are made to this Pre-
Ordering and Ordering Guide for LQS will be reflected accordingly in this section of the 
document. 
 

Section Date / Version Description 
   

All 8/27/2002 – Version 3 This document is an original 
version.  

   
General revision to include 
instructions for using 
Address-Based Qualification 
and enhanced error codes 
associated with the 
availability of LQS GUI 
Version 3.0.   

01/16/2003 – Version 4 Updated Version Release 

   
Minor corrections made to 
entire document, includes 
conditional Address 
qualification clarification. 

03/19/2003 – Version 5 Updated Version Release 

   
General revision.  New service 
field, reason codes, logic 
sequence and FAQ’s added. 

08/25/2003 – Version 6 Updated Version Release 

   
General Revision adding 
Automatic Forced Refresh of 
Address Keys, Reminder 
Message On Address 
Qualification.   

12/01/2003 – Version 7 Updated Version Release 

   
Updated ADSL Speed code 
chart. 

01/27/2004 – Version 8 Updated Version Release 

   
Addition of Sup Field and 
Address Key, updated ADSL 
Speed code chart  

04/27/2004 – Version 9 Updated Version Release 

   
General Revision.  Addition of 
LQS R16 enhancements.  

11/15/2004 – Version 10 Updated Version Release 
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Chapter 2.0:  Overview 
 
LQS was originally designed as an internal tool utilized by BellSouth and Internet Service 
Providers (ISPs) reselling BellSouth ADSL (Asymmetric Digital Subscriber Line) Service to 
determine if a telephone number(s) at a specific service address qualified for BellSouth ADSL 
Service.  Subsequently, LQS access has been made available to any requesting D/CLEC via 
the Interconnection Agreement. For further specifications on the BellSouth ADSL offering, 
refer to the BellSouth Access Tariff – FCC (Federal Communications Commission) Number 1.  
This can be located at the following web address: 
 

http://cpr.bellsouth.com/pdf/fcc/fcc.htm

While the information returned via LQS may provide some indication of loop characteristics, it 
does not provide the level of detailed information Mechanized or Manual Loop Makeup (LMU) 
provides.  For more information on BellSouth’s Loop Makeup product, refer to the BellSouth 
LMU CLEC Information Package located at the BellSouth Interconnection Services Web site 
in the CLEC Products Section at:  

http://www.interconnection.bellsouth.com/guides/html/unes.html  

The Loop Qualification System (LQS) described in this guide is for D/CLECs to utilize when 
accessing BellSouth’s LQS.   Additional information can also be obtained by accessing the 
LQS web site at the following address:  

http://lqs.bellsouth.com

Note:  To access this site, a USER ID and password is required.  Information relative to 
obtaining the User ID and password is contained within this document. 

2.1 Telephone Number-Based DSL Loop Qualification 
 
A user can perform an on-line query on up to five (5) manually entered telephone 
numbers simultaneously.  The current offering limits a User ID (Identification) to 2,000 
qualifications in a 24-hour period.  A user can also submit up to 1,000 numbers at once 
using the Bulk Submit utility to submit an ASCII file.  The 2,000 number-limitation also 
apply  to bulk submissions.   

2.2 Address-Based DSL Loop Qualification  

 
The LQS application can accommodate both Telephone Number-based and Address-based 
DSL Qualification and therefore replaces any previous version of the LQS Telephone Number-
based application.   
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Chapter 2.0:  Overview (continued) 
 
Refer to Chapter 4.0 of this document for specific instructions relevant to downloading the 
desktop GUI (Graphical User Interface) application and the necessary technical notes and API 
java files. 
 
 
The information contained in LQS is derived from the Loop Engineering Assignment Data 
(LEAD) Database and provides a “best effort” response regarding a loop’s ability to support 
BellSouth’s ADSL service.  
 
The LEAD Database is a once-per-month-per-wire-center “snapshot” of the information 
contained in the Loop Facilities Assignment and Control System (LFACS) Database.  1/30th of 
all wire centers are updated every day.  Currently there is a 98% accuracy rate on returned 
responses within LQS. LQS cannot be guaranteed based solely on the system response.  
Guaranteed service of BellSouth’s Business Class ADSL does not utilize LQS but instead 
requires a Service Inquiry (SI).  
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Chapter 3.0:  Pre-Ordering Guidelines 
 
3.1 Availability 
LQS is available within all nine states of the BellSouth region.  
 
 
3.2 Contract Specific Guidelines 
For LQS access to be provided, the D/CLEC must have an Interconnection Agreement that 
includes the terms and conditions for the service.  To establish access to the LQS System, the 
D/CLEC will contact their CLEC Care Representative.  Access to the LQS System will require 
a minimum of two (2) business days from the date of the request.     
 
 
 
If a D/CLEC requests access to LQS and access is not already covered by the existing 
Interconnection Agreement, the Contract Negotiator should be contacted to provide the 
appropriate amendment.  
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Chapter 4.0:  Ordering Guidelines 
 
Once it has been confirmed that a D/CLEC is authorized via the Local Interconnection 
Agreement or an amendment has been added to the existing contract to utilize the LQS 
System, a User Name and Password must be obtained.  The sections beginning below list the 
steps necessary to establish access and utilize the LQS System.   Detailed information on the 
BellSouth LQS application is available at the following web site: 
 

http://lqs.bellsouth.com/Application.html
 
 
4.1 Establish/Discontinue Access to LQS 
The D/CLEC will contact their CLEC Care representative to establish or discontinue access to 
the LQS System.   It is the responsibility of the D/CLEC to provide a User Name.  The User 
Name must consist of eight (8) case-sensitive characters.  LQS requires the User ID to reflect 
the NSP (Network Service Provider) name.  In addition to reducing word collision, it is easier 
to administer because it is more stable than a person’s personal name or title.  Examples of 
good User IDs include “abraxis”, “dscadsl”, and “flashcom”; User IDs considered not good 
include "admin", "andrea", and "pguthrie". 
  
A password must be 6 to 12 alpha/numeric characters.  For security purposes, it must contain 
at least one numeric character and one letter. Choose a password that is easy to remember 
yet difficult for someone else to guess. Passwords are case-sensitive. 
 
A “difficult to guess” example could be FoxNBear23; “network”, “names of people”, “famous 
places”, and “derivatives of the company name are relatively easy to guess.   
   
This information will be furnished to BellSouth at the time the request is initiated.  Once the 
request is initiated, it will take a minimum of two (2) business days to get the access 
established.   
 
If it becomes necessary to discontinue the password and delete the account in the LQS 
System, the D/CLEC is responsible for contacting his/her LSM.  The User Name on the 
account to be discontinued must be furnished at the time the request is initiated.    
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Chapter 4.0:  Ordering Guidelines (continued) 
 
4.2 Installing the LQS Application and Accessing the System 
Instructions on downloading the latest version of the LQS desktop GUI (Graphical User 
Interface) application and general use information including the necessary technical notes and 
API java files are available on the LQS website located at the following web address: 
 

http://lqs.bellsouth.com
 
Once access has been established, the following steps will be taken to log into the LQS 
System: 

• Double click the BellSouth Loop Qualification icon on the PC (Personal 
Computer) Desktop.  (The LQS Login box will appear.) 

 
• Enter the User Name and Password. 

 
• When logged in successfully, the main window will be displayed.  

 
NOTE:  All of the windows in the LQS GUI are resizable. If the results cannot be seen 
completely, try resizing the window.  
 
Main Window 
 
The main window has two search and qualification views.  Use tabs to select views.  The 
system defaults to the Telephone/Address Key search and qualification view: 
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Chapter 4.0:  Ordering Guidelines (continued) 
 
LQS returns the following message on all qualified address queries: 
 

ATTENTION: Possible service conflict may exist on some lines at this address.  
Please perform telephone number qualification. 

To see the Address search and qualification view, click on the "Address" tab.  It will look like 
this:  
 

 
 
Once the Status window appears, a Query may be submitted.  
 
When performing loop qualification by Telephone/Address Key, LQS qualifies the loop 
supporting the telephone number that was specified.  When performing loop qualification by 
address, LQS generically qualifies the living unit.  The process used to determine the 
qualification status is somewhat different based on which input (telephone number or address) 
is entered.  When qualifying by telephone number, both the electrical makeup of the loop and 
other non-electrical criteria are used to determine the qualification status.  LQS checks for 
incompatible services on the voice loop and incompatible classes of service.  Either of these 
conditions will result in LQS disqualifying a loop when a telephone number is used.  Address-
based loop provides a conditional qualification because it uses only the facilities to determine 
the loop qualification status.  Even though the facilities are determined to be qualified, it may 
still be possible for the individual loops at that location to be disqualified due to incompatible 
USOCS, etc.  A subsequent telephone-number based qualification should always be 
performed on the actual telephone number that the DSL is to be ordered on.  This will be 
discussed in more detail in the sections that follow.  
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Chapter 4.0:  Ordering Guidelines (continued) 
 
4.3 Telephone/Address Key-Based Qualification  
To qualify a telephone number (TN) or an Address Key (AK), select the "Telephone/Address 
Key" tab from the Main Window.  Type a telephone number or address key into the first TN/AK 
field.  Press <Tab> to move to the next field and enter another TN or AK.  Note: Address Keys 
(AK) must start with the '@' character.  To perform the qualification, click on either the 
"Qualify" button or press <Enter>.  The Qualification Results will appear next to the TN/AK’s 
as shown in the example.  
 
 
 

 
 
 
 
 
 
 
 
 
 
 

 
 
 
 

11

Your Interconnection Advantage             
 

 



  
________________________________________________________________  
Loop Qualification System (LQS)  
CLEC Pre-Ordering and Ordering Guidelines 

 
BellSouth Interconnection Services         Date of Posting 11/15/2004  

SM Version 10  

Chapter 4.0:  Ordering Guidelines (continued) 
 
If the result button includes a “down arrow” symbol, then there is additional information for that 
result.  Click on the result button to view the additional information:  
 
 
 

 
 
 
 

 
 
If the text field that contains the second TN/AK is clicked and the user begins to edit that field, 
the results for that TN/AK will be cleared.  This prevents old qualification information from 
being incorrectly interpreted as belonging to the new TN/AK:  
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Chapter 4.0:  Ordering Guidelines (continued) 
 

 
 

 
 
 
The result button for the second TN is now empty, because the last digit from the second TN 
was deleted.  
 
It is possible to qualify multiple TNs, using only the keyboard, by following these steps:  
   

• Enter a single TN in one of the input fields.  
 

• Depress <Enter> to qualify it.   
 
The result will appear.  Since the keyboard focus has not changed, the <Backspace> may be 
depressed to edit the current TN.  When the TN editing is completed, depress <Enter> again 
to qualify it.  All of the results will be saved in the Transcript.  The Transcript screen will be 
discussed later in this chapter.   
 
It is also possible to qualify multiple TN’s using the Bulk Submit Utility. 
   
Note:  Information needed to interpret the results of the qualification is included within this 
chapter.   
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Chapter 4.0:  Ordering Guidelines (continued) 
 
 
The LQS Bulk Submit Utility method may be selected to query qualification results for up to 
1,000 telephone numbers at one time.  The telephone numbers must be contained in the 
ASCII file format including one 10-digit telephone number per line excluding hyphens and 
containing no titles, headers, or footers.  From the LQS Main Window, the following steps will 
be taken: 
 

• Select “Utilities” from the Menu Bar 
 

• Select “Submit Bulk File” 
 

• Select the file containing the telephone numbers 
 
When completed, the “LQS Bulk File Results” Window will display indicating the status for all 
of the telephone numbers submitted on the bulk form.  The user has the option at this point of: 
 

• Selecting the contents and copying them to another file 
 

or 
 

• Saving the contents to another file 
 
Note:  Information needed to interpret the results of the qualification is included in this 
chapter.   
 
4.4 Forced Refresh 
 
The refresh cycle of data from each Central Office may take LQS up to 30 days to reflect the 
current status of a telephone number.  LQS provides the ability to submit a "forced refresh” on 
the qualification status of telephone numbers in LQS.  Within 48 hours, the new loop 
information will be reflected in LQS. (Depending on load, the update may take up to 72 hours).  
For all LQS users, if LQS returns N, E6, an automatic refresh is initiated and LQS will return 
the most recent loop information associated with the telephone number within 48 hours.  
 
If LQS returns “N” (not qualified) with an E2, E3, or E4 and the CLEC believes that the end-
user recently moved to an ADSL qualified address while keeping the same telephone number 
or that the end-user recently made a change to their local voice service that should qualify 
their number for ADSL, the CLEC can initiate a "forced refresh" using LQS.  A forced refresh 
is initiated in LQS by inserting a minus sign (or dash) in front of the telephone number and 
clicking "Qualify". LQS will return "N, R, Refresh Loop Data". 
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Chapter 4.0:  Ordering Guidelines (continued) 
 
Automatic Forced Refresh of Address Keys 
When LQS is unable to locate any information for a particular living unit/address LQS returns 
the message:  “Adr.1 The Street Address Guide System was unable to supply an address key 
for this address”.  The result is the address qualification determination cannot be made until 
the telephone number is qualified in LQS.  If LQS is unable to obtain an Address Key for a 
given address, LQS will return:  “Adr.3 LQS requires updated data for this address.  A refresh 
has been requested”.  LQS will automatically initiate a forced refresh of the Address Guide 
System to obtain the current address information if it exists.  After 48 hours of the automatic 
refresh, the user should attempt another qualification on that address.  If the Address Key is 
found and the address is qualified, LQS will present the Address Key.  If the Address Key is 
found and the address is not qualified, LQS will not display the Address Key and will indicate 
that the address is not DSL capable.  If the Street Address Guide System was still unable to 
provide an address key after an auto-refresh, LQS will continue to return the message: “Adr.3 
LQS requires updated data for this address.  A refresh has been requested”. 
 
 
4.5 Address-Based Qualification 
The LQS GUI has the ability to search for an address.  If a single address can be found, and 
that address matched to an address key, the address key can be qualified.  
 
Unfortunately, addresses are not as precise as telephone numbers, so some searching may 
be required before the exact address can be identified.  
 
To search for an address, select the "Address" tab and enter the appropriate information in the 
text fields.  Search on the address at any time by clicking on the "Search" button, or by 
pressing <Enter>.  
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Chapter 4.0:  Ordering Guidelines (continued) 
 
If enough information is not entered, an error message will be displayed in the Messages 
view, and the focus will be moved to the suggested text field.  The label associated with that 
text field will turn red (and the text field will flash red) to help in identifying the correct field.  In 
this example, only the Street Number and Street Name were entered:  
 

 
 

 
 
The City field has been highlighted in accordance with the error message displayed at the 
bottom.  
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Chapter 4.0:  Ordering Guidelines (continued) 
 
The City field will now have the keyboard focus.  In this example, part of a city name was input 
and pressed <Enter>.  An error message appeared indicating that a state needs to be 
selected.   
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
The State label will turn Red and the State menu will have the keyboard focus.  Click on the 
State pull down menu (or press <Space>) and the State menu will appear:  
 
A state may be selected by clicking on its two-letter abbreviation or by using the arrow keys 
and moving the selection to the correct state and depressing <Space> or by depressing the 
first letter of the state abbreviation and depressing <Space>.  
 
Note:  Select a state quickly by typing in the first letter of the state abbreviation without 
opening the state menu first.  
 
To perform the search, click on the "Search" button or depress <Enter> even when the focus 
is on the State Menu and whether it is opened or closed.   
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Chapter 4.0:  Ordering Guidelines (continued) 
 
If a valid address has been entered, the system will automatically submit the valid address to 
verify if there is an address key associated with it. There is only one match to that address in 
the system.  If there is an address key, the Address Key field will display it and LQS will 
automatically try to qualify it.  If there is an address key, the Address Key field will display it 
and LQS will automatically try to qualify it.  
 
The qualification results will appear in the Qualification Status view (and the Transcript).  In 
the above example, when "A" was selected for Alabama and "Search" is clicked, the response 
shown on the next page will be provided. 
  
 

 

 
 
 
 
Notice that the city name has been expanded to "Birmingham" (from "Bir") and the zip code 
has been entered.  All of the information does not need to be entered to make an exact 
address match.  When a match is made, any missing information will be filled in.  However, 
when more information is entered, there will be a better chance of making an exact match.  
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Since a qualification occurred, the results are also displayed in the Transcript.  An example of 
this screen is shown on the next page. 
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Chapter 4.0:  Ordering Guidelines (continued) 
 

 
 
Notice that the address and the address key are displayed instead of a TN.  
 
 
4.6 Narrowing The Address Search 
If, however, address information is entered and a search does not find an exact match, the 
search must be narrowed.  In the example on the previous page, if a street name of "River 
Trace" had been entered instead of "River Trace Cir", an exact match would not have been 
found.  
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Chapter 4.0:  Ordering Guidelines (continued) 
 
 A message will appear in the Messages view:  
 
 
 

 
 
The Search Results list will contain the list of suggested addresses.  An address may be 
selected from that list.  When an address is selected, the information from that address will be 
automatically copied into the text fields.  Double clicking on the selected address or 
depressing <Enter> will perform the search again.  
 
As with the TN qualification, if any of the data in an address search is changed, the results 
from the previous search will be cleared so they cannot be incorrectly interpreted as belonging 
to the new address.  
 
Clear all of the information on the screen by clicking the "Reset" button.  
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The address system prefers abbreviations for some parts of the street name.  Here are some 
examples:  
 

Street Name Abbreviation 
  

Boulevard BLVD 
  

Circle CIR 
  

Court CT 
  

Lane LN 
  

Road RD 
  

Street ST 
  

Trace TR 
 
Abbreviations MUST be used to obtain an exact match.  The address database does not 
contain data for the non-abbreviated words.  

 
Tips when inputting Addresses (example): 
 
Formatting of Addresses In the BellSouth database, 

100 South Main Street would typically be formatted as 100 S Main St 
100 First Drive would be formatted as 100 1st Dr 
100 Hwy 41 would be formatted as 100 Highway 41 
100 Jefferson Highway would be formatted as 100 Jefferson Hwy 

 
Required fields on an address query are: 

• Street Number 
• Street Name 
• Either City or Zip Code (Zip codes typically return more accurate 

results) 
 
If more than one similar address is returned, use the “scroll bars” if they appear to see other 
addresses that may not be readily visible in the results window. 
 
Note: Not all addresses have address keys.  A search for an address may provide a result 
without an address key.  Unfortunately, there is little that can be done at this point.  Addresses 
cannot be qualified that do not have an address key.   
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4.7 Interpreting Query Results 
There will be a Reason Code displayed for each telephone number queried.  The Reason 
Codes include: 
 

A  (Available) – The loop is currently qualified for ADSL or PC Data. 
 

P  (Planned) – The loop is currently not qualified but is projected to support 
ADSL or PC Data.  Projected service date will be included with initial 
feedback. 

 
N  (Not Qualified) – The loop is not qualified for ADSL or PC Data or    the 

loop qualification status cannot be determined with certainty because of 
missing data or some other error condition. 

 
When an “A” or “P” response is received, the following codes will also be shown immediately 
following the Reason Code: 
 

• “C” for Copper or an “F” for Fiber 
 

• Speed Code will follow a loop qualified as A,C (Available, Copper) 
 

• “Planned Date” will follow a loop qualified by “P” (“Planned”) 
 

• An external “Reason Code” and description (E*) will follow an “N” (“Not 
Qualified”) response 

 
Additional information on positive and negative responses is available in Sections 4.4 and 4.5 
of this document.  Typical response formats include:   
 

A,C,C5 
 

or 
 

P,C,L0,2000.01.01 
 

or 
 

N,E2  
(Service not available for this telephone number) 
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4.8 Typical LQS Output Screen 
The Internal Reason Code and Enhanced LQS GUI (Graphical User Interface) fields are 
displayed for each telephone number queried and is viewable via the drop down arrow 
indicated with a + sign which means additional information is available. 
 
Following is an example of a typical output screen provided by the LQS Enhanced GUI: 
 

N,E2,Service not available for this phone number. 
I2,Copper loop is loaded. 
dt=,rz=15,cz=9,sc=pots1{ADSL},cap=null, 
Loopbits={isF1CableLoaded,IsRc,hasTnId},wkg 
NpaNxx(205298,hm=brhmalch,{},#p=1,#l=1996) 
WC(brhmalch,10/08/2001,205967,tdl=18.0,cap({ADSL},<no date>),{}) 
LivingUnit(1auc6.4,sz=1,cap=null) 
WireCenterProxy(205298,brhmalch,{},#l=1996) 
Taper(111901,{},(14.1+3.9=18.0)) 
F1Cable(8,{}),p=136 
DT(r 3827 river view dr,{},cap{},<no date>,null,(0,0,0)) 
XB(802,{},cap({},<no date>),(396,16,0),p=1036 
 

Provided below is an explanation of each line item with a copy of the line output from the 
above example as reference.  The general format of this explanation will be: 
 

<Line Number>, <Item Name if multiple item line>, <Explanation> 
 

Note:  If a line or line element has the message “not a network data element”, this data item 
is LQS software system oriented and does not contain pertinent information relative to the 
loop qualification; therefore, a definition of this element will not be provided. 
 
 
4.9 Line-By-Line Explanation of LQS Output Screen  
Beginning below is a line-by-line explanation of the data included on the LQS Output Screen. 
 
Line 1 – External Reason Code Qualification Response: 
 
Output:  N,E2,Service not available for this phone number. 
 

1, Loop Qual Response/External Reason Code  
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Line 2  - Internal Reason Code Qualification Response: 
 
Output:  l2,Copper loop is loaded. 
 
 l2, Loop Qual Response/Internal Reason Code  
 
Line 3 – Specific Data Associated with the Telephone Number: 
 
Output:  dt=,rz=15,cz=9,sc=pots1{ADSL},cap=null, 
 
 3, dt = Data Type 
 
  min = remote DSLAM fed straight F1 terminal 

pcd = IFTL Ethernet based service 
fmx =DIFTL (Data over Fiber In The Loop) based service 
fax =DIFTL (Data over Fiber In The Loop) based service 
null=no data type detected by refresh program 

 
3, rz = Resistance Zone of Customers Serving Terminal   
 

RZ is an indicator of the subscriber loop resistance limits of a particular 
geographic area. Used for metal facilities (e.g., RZ13=1300 ohms, RZ15=1500 
ohms.)   
 

  Values typically = null, 13, 15, 18, etc. 
 

3, cz = Carrier Resistance Zone of Customers Serving Terminal   
 

CZ is an indicator of the maximum resistance between the remote terminal 
cabinet and the customers serving terminal. Used for derived facilities only 
(e.g., CZ9=900 ohms.) 
 

  Values typically = null, 9, or 15 
 

3, sc = Service Category       
 

Service Categories map to 15 Outside Plant Equivalence Code (OEC) 
parameters that describe the relevant characteristics of the service from an 
outside plant provisioning perspective.  These OEC parameters allow LFACS  
Center to accurately select the outside plant facilities with the appropriate 
transmission characteristics.   
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3, sc = Service Category  (continued)     
 
The OEC parameters include the number of conductors required, the manual 
assistance indicator, the grade of service (party line or single), class of service, 
pair gain indicator, non-local indicator, category (i.e., voice grade, digital data, 
ISDN (Integrated Services Digital Network)), CO (Central Office)-side 
terminations, quality, signaling, metallic requirement, digital data rate, loop 
assignment type, loop qualification, and de-specialization.   
 
By matching these parameters, LFACS is able to determine which OEC 
category a service request falls into and in turn, to know what type of facility to 
look for.  The address tells LFACS where to look.  
 

• POTS (Plain Old Telephone Service) 1 is a 2-Wire, single-party, voice 
grade loop, “S” type CO terminations with ordinary loss levels, loop start 
signaling, metallic facilities not required, and any DD rate.   

 
• POTS3B is a 2-Wire, 4 or 8 party voice grade service, “B” type CO 

terminations, ordinary loss, loop start, no metallic requirement, and any 
DD rate.   

 
• POTS5 is a 2-Wire, single party, voice grade, “C” type CO terminations, 

ordinary loss levels, loop start signaling with no metallic requirement 
and any DD rate.   

 
• DOV 4 is a 2-Wire single party, locally or non-locally switched voice 

grade, “M” type CO terminations, ordinary loss, loop, ground or battery 
start that could or could not have a metallic requirement with an “L” 
digital design rate.   

  
Values typically = pots1, pots3b, pots5, dov4 
 
Note:  3, cap = Line Capability in the software system.  This is not a network data 
element. 
 

Line 4 – Specific Data Associated with the Telephone Number 
 

Output:  Loopbits={isF1CableLoaded,IsRc,hasTnId},wkg 
 

IsRc - = System Item Status  
 
  This is not a network data element. 
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Wkg = Pair Evaluation (PE) Status of Telephone Number 
 
  wkg = normal line in service with a telephone number 
  

ct    =  connect through  - A loop from the central office to the serving terminal that 
remains “connected” through the network. This allows the next customer who moves to 
that location to have dial tone initiated at the central office without cross connects 
being required in the field. 

 
Valid loop statuses include: 

 
• CT (Connect Through)  

 
• CF or CNF (Connected Facility)  

 
• PCF (Partially Connected Facility)  

 
• WKG (Working)  

 
• RCT - Connect through originating at a switcher 

 
• RCF  - Connected facility originating at a switcher 

 
• RWK - Working loop originating at a switcher  

 
• IDLE  

 
Note:  Of these, only WKG and RWK are working values. 
 

Values typically = wkg, ct, etc. 
 

Line 5 – System Oriented NPA, NXX  
 
Output:  NpaNxx(205298,hm=brhmalch,{},#p=1,#l=1996) 
 
   Note:  This is not a network element. 
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Line 6 – Wire Center Level Data 
 
Output:  WC(brhmalch,10/08/2001,205967,tdl=18.0,cap({ADSL},<no date>),{}) 
 

6, <wc clli> = LEIS  8 character wire center CLLI (Common Language Location Identifier) 
                      Code 
 
6, mm.dd.yyyy = extract date of current wire center data being used in Loop Qual 

 
6, npanxx = primary npanxx of this wire center 

 
6, tdl = wire center specific taper code dead length. If the taper code exceeds this 
length, all lines are disqualified to minimize false positive qualifications 

 
6, cap = system software parameter indicating ADSL capability and date if planned  

 
Line 7 – Living Unit Data 
 
Output:  LivingUnit(1auc6.4,sz=1,cap=null) 
 
The Living Unit ID (LUID) is a value from LFACS for this specific address utilized by the 
system software.  This is not a network data element. 
 
Line 8 – System Oriented Wire Center Proxy Data 
 
Output: WireCenterProxy(205298,brhmalch,{},#l=1996) 
 
This data has no value to a Network user.  This is not a network data element. 
 
Line 9 – Taper Code Information 
 
Output: Taper(111901,{},(14.1+3.9=18.0)) 
 

9, <taper code> = the taper code of the customers serving terminal 
 

9, XB = the x-box that LQS associates with this taper code.  This data can be 
ambiguous if there are multiple taper codes associated with an x-box. 

 
9, (f1.f1, f2.f2, tot.tot) = Outside Plant District provided; F1/F2/Total distances for this 
taper code 

 F1 = distance from the central office to the x-box for copper fed x-boxes 
F2 = maximum distance from x-box to the distribution terminal for that taper code 

 
(Continued on the next page) 
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Line 10 – F1 Cable Information  
 
Output: F1Cable(8,{}),p=136 
 
 F1 = First Loop Segment for the CO 
 

10, F1 cable = F1 cable assignment 
 

10, F1 pair = F1 pair assignment 
 

Line 11 – Serving Terminal Information 
 
Output: DT(r 3827 river view dr,{},cap{},<no date>,null,(0,0,0)) 
 

11, provides serving terminal name in LFACS database 
 

11, cap = system capability for this terminal and date if planned 
 

11, (aaa,bbb,ccc) = working line info for this x-box 
  

aaa = total lines working in this terminal 
 

bbb = copper ADSL qualified lines working in this terminal. (Qualified from the 
CO.)  

  
Note:  A remote DSLAM (Digital Sub Line Access Multiplexer) makes this 
          number irrelevant.  

 
ccc = pg lines working in this terminal 
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Line 12 – FN/F2 Crossbox Information 
 
Output: FnCrossBox(802,{},cap({},<no date>),(1,0,0),null),p=1036 
 
 F2 = Second Loop Segment from the CO. 
 

12, FnCrossBox = the f2 cable name associated with this telephone number 
values = null if none, f2 cable name, or mr/ahj name if existing ADSL service 

 
12, cap = system capability for this x-box and date if planned 
 
12, (aaa,bbb,ccc) = working line info for this x-box 

  
aaa = total lines working in this x-box 

 
bbb = copper ADSL qualified lines working in this x-box. (Qualified from 
the CO.)  
 

Note: A remote DSLAM makes this number irrelevant.  
  

ccc = pg lines working in this x-box 
 

12, pair = F2 pair assignment.  
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4.10 Internal Reason Codes  (Positive LQS Response) 
Internal Reason Codes are provided for positive Internal Response Results.  In order to 
properly understand the Internal Response Results, the following information is furnished to 
provide an explanation of the possible Internal Reason Codes. 

When a High Density DSLAM is deployed in the Central Office or Remote Terminal, the LQS 
web GUI will return a second row of information.  If EDSL can be supported at the address 
where the telephone number is working, this information will contain the previously mentioned 
High Density indicator (i.e., coHD or remote HD).  If there is not an HD indicator, the regular 
IQ line will be the 2nd line.  An example is of this is shown below: 
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 IQ1 = Copper-qualified loop  
 

This copper loop does qualify for ADSL service. 
  

IQ2 = Pair Gain loop qualified with copper-qualified cross-box  
 

This customer is currently served via Digital Loop Carrier (DLC) that will not 
support ADSL service.  However, records indicate 10 or more qualified copper 
pairs do exist at the cross-box.  A Facility Reservation Number must be 
obtained by the D/CLEC in order to move the customer to an unloaded copper 
pair suitable for Line Sharing.  

IQ3 = Qualified through Remote DSLAM on cross-box 
 

 This response code means BellSouth has an existing remote solution (Remote 
DSLAM) available in the Remote Terminal (RT) in which this customer receives 
their voice service.  

NOTE: Due to the proactive logic in LQS, this code masks any other codes 
describing the loop currently serving the customer.  The only valid assumption 
will be that the F2 portion of the customer loop is qualified for a type of ADSL.  

IQ4 = Qualified through Straight F1 on distribution terminal  
 

This copper loop does qualify for ADSL service and is served by an F1 facility 
only.  (It does not pass through a cross-box). 

IQ5 = Qualified through CMS  Update  
 

     BellSouth has an existing or planned Integrated Fiber In The Loop (IFITL) 
remote solution serving this customer.  

IQ6 = F1 Loaded loop qualified by copper-qualified cross-box  
 

This customer is currently served via a loaded copper pair that will not support 
ADSL service.  However, records indicate 10 or more qualified unloaded copper 
pairs do exist at the cross-box. A FRN must be obtained by the D/CLEC in order 
to move the customer to an unloaded copper pair suitable for Line Sharing. 

  IQ7 = F1 Loaded qualified by copper qualified distribution terminal 

 This customer’s specific pair will not support ADSL service.  However, other 
pairs in this customer terminal can provide ADSL service and it is allowed to 
qualify on the assumption the line can be moved to an ADSL capable pair. 
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  IQ8 = PC Data qualified through LEIS-LEAD update 

  BellSouth has an existing IFITL remote solution serving this customer that is 
capable of carrying ADSL service.  

 
IQ9 = Qualified by RZ override 

 
A system override of the stored RZ has been applied.  This occurs when the 
F1+F2 distance < 14.0 KF. 

 
IQ10 = Qualified for ADSL over fiber- MX  
 

BellSouth has an existing or planned Data Over Fiber In The Loop (DFITL) 
remote solution serving this customer.  

 
IQ11 = Qualified for ADSL over fiber- AX  
 

BellSouth has an existing or planned DFITL remote solution serving this        
customer. 

 
IQ12 = Force-qualified through remote capability on individual loop. 

 
Loop manually forced to qualify for some reason.  Generally, this means there 
is a field notification of a records problem in LFACS.  It is force qualified to 
insure it will qualify in the system.  

 
IQ13 = Pair Gain qualified by copper-qualified distribution terminal 
 

This customer’s specific pair will not support ADSL service.  However, other 
pairs in the customer’s terminal can provide ADSL service and it is allowed to 
qualify on the assumption the line can be moved to an ADSL capable pair.  
This is the same as IQ7 but on a pair gain rather than a loaded F1 pair. 

 
IQ14 = Conditional qualification; CO DAML 
 

An unqualified DAML line may now be allowed to qualify.  In addition, an 
assessment is made to determine the ability to provision ADSL service.  A 
DAML is an electronic unit that puts two (2) telephone numbers on one 
copper/pair gain facility.  This renders the line unusable for ADSL service and 
this new qualification requires a review of the facility to provide ADSL service, if 
possible. 
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 IQ15 = Address qualified by copper-qualified cross-box 
 
 IQ16 = Address qualified by remote capability on crossbox. 
 
  IQ17= Address qualified by copper qualified distribution terminal  
 
 IQ18 = Address qualified by remote capability on distribution terminal 
 
 IQ19 = Forced qualified by manual override. 
 

IQ20 = Conditional qualification.  Full PG DAML. 
 
IQ21 = Partial PG DAML 
 
IQ22 = Business line only area.  Loop is business USOC    
 
E6  = When the loop data does not exist in LQS, the external code E6 is given 
          and repeated in the internal code field> 
 
 
 
 

4.11 Speed Codes   
In addition to Internal Reason Codes, Speed Codes are also furnished with “positive” 
response codes.  In order to properly understand the Internal Response Results, the following 
information is furnished to provide an explanation of the possible Speed Codes. 

The table on the next page provides translations for speed codes returned in LQS for loops 
qualified as A, C.  The speed code indicates the conservative maximum BellSouth ADSL 
service rate that may be purchased for that loop without a Service Inquiry.   
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LQS RETURN CODES (MAXIMUM SPEED SUPPORTED BY A QUALIFIED LOOP) 
 
Speed Code Estimated 

Maximum 
Distance 

Business or 
Industrial 

USOC Downstream 
Rate 

Upstream 
Rate 

      
A5 6.5KF Business Class ADF51 4-6 Mb/s 640 Kb/s 

      
B5 8.0KF Business Class ADF41 2-4 Mb/s 640 Kb/s 

      

C5 9.4KF Business Class ADF31 
1.5 Mb/s 
minimum 

512 Kb/s 
minimum 

      

D5 9.5KF Business Class ADF61 
768 Kb/s 
minimum 

512 Kb/s 
minimum 

      

E5 12.0KF Business Class 
ADF21 
ADF22 

384 Kb/s 
minimum 

384 Kb/s 
minimum 

      
E9 (*) 13.0 KF Residential Class ADF91 3.0 Mb/s max 384 Kb/s max 

      

F5 15.5KF Business Rate ADF71 
192 Kb/s  
minimum 

192 Kb/s 
minimum 

      
      
      

 
L0 and G5  

     
0.0-18.0KF  

Mass Market 
Consumer rate 
 
 Residential 
Class  

 

 ADF11, 
ADF01 

1.5 Mb/s max 
256 Kb/s max 

256 max 
128 Kb/s 

(*) The 3mbps service indicator in the SVC line is the definitive indication for 3Mbps service for qualification. 
Notes:  
New E9 code:  The 3m x 384k BBG service is dependent on both the loop length and the type 
of BellSouth DSL equipment serving the customer’s area.  The E9 speed will be used to 
indicate that the customer’s “loop length” can support the 3meg service, but actual 3meg 
service availability is also dependent on the serving equipment and is communicated in the 
SVC field (see below).  To summarize: 
 
� , A5 through E9 will indicate 3meg availability. 
� F5, L0, and G5 will indicate that 3meg is not available. 
� As a rule, you should always check for a SVC indicator of “3Mbps” to confirm 3meg 

availability. 
� An NSP must be on the Broadband Gateway platform to order the 3meg service. 
 
 

35

Your Interconnection Advantage             
 

 



  
________________________________________________________________  
Loop Qualification System (LQS)  
CLEC Pre-Ordering and Ordering Guidelines 

 
BellSouth Interconnection Services         Date of Posting 11/15/2004  

SM Version 10  

 

Chapter 4.0:  Ordering Guidelines (continued) 
 
 “SVC” field - As BellSouth’s suite of DSL services expand beyond basic ADSL, these new 
service capabilities will be displayed in the SVC field. The 3Mbps indicator will be presented 
beginning 2/27/04.  An example of the LQS response follows:  

A, C, D5 
HD: coHd 
SVC={mpvc, business, 3Mbps}  

 
This means that the customer’s loop length can support speeds offerings of D5 (or lower) and 
the serving equipment is a high-density DSLAM and can support Business Class ADSL, Multi-
PVC, and the 3meg service. 
 
Similarly if there is a DSLAM deployment planned for a 03/11/2004 service date, and the 
proposed DSLAM will support Business Class and Multi-PVC service, the LQS response for 
the previous example will be formatted as follows: 

P, C, D5, 03/11/2004 
HD: coHD, 03/11/2004 
SVC={3Mbps =(=03/11/2004),mpvc, business} 
 

LQS will display the serving CO CLLI (Common Language Location Identifier) code for any 
valid or recognized telephone number, address, or address key query.  This code is useful in 
validating the CO serving area that your potential customer resides in.  The CO CLLI will be 
presented on a new “SUP” line.   
  

SUP={wc=lrvlgaos}  (Note: lrvlgaos is the CO CLLI for the Lawrenceville CO) 
AdrKey:@i1P0LiB  (Note: The @ symbol is not part of the Address Key) 

 
Finally  should LQS ever return a speed code that is not included on the table above, you 
should qualify that telephone number/address and treat that unrecognized speed code as 
“L0”.  This is particularly important if you have built a web interface to LQS and have 
programmed your interface to recognize specific speed codes.   
 
G5 code:  From a “service availability” perspective, there is no difference between G5 and L0.  
Both codes indicate that the telephone number or address qualifies for both the residential 
class 1.5m x 256k service and the 256k x 128k BBG service.   
 
Regarding loop qualification, a “serving area” may be made up of one or more neighborhoods 
and/or business areas.  With the implementation of LQS release 11.0, G5 will indicate that 
the serving area for a particular qualified customer contains loop lengths up to 18kf.  
Some customers in the serving area may have loops shorter than 18kf, but the maximum loop 
for any qualified customer in this serving area is 18kf.  L0 will indicate that the loop is 
qualified for ADSL service, but the maximum loop length for the customer’s telephone 
number or address is indeterminate.  The remaining speed codes associated with Business 
Class availability follow the same pattern as G5.   
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4.12 Positive Response Results 
 
The following table indicates the format of possible External and Internal Reason Codes for 
positive response results received from LQS. 
 
 

External Reason Code Internal Reason Code 
  

A, C, Speed Code IQ1, Copper-qualified loop 
  
 IQ2, Pair Gain loop qualified with copper- 

Qualified cross-box  
  
 IQ3, Qualified through Remote DSLAM on 

cross-box.  
  
 IQ4, Qualified through Straight F1 on 

distribution terminal 
  
 IQ6, F1 Loaded loop qualified by copper- 

qualified cross-box  
  

 IQ9, Qualified by RZ Override 
  
 IQ15, Address qualified by copper 

qualified cross-box 
  
 IQ16, Address qualified by remote 

capability on cross-box 
  
 IQ17, Address by copper-qualified 

distribution terminal 
  
 IQ18, Address qualified by remote 

capability on distribution terminal 
 
The table continues on the next page. 
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External Reason Code Internal Reason Code 
  

A, F IQ5, Qualified through CMS update 
  
 IQ8, PC-Data qualified through LEIS-LEAD 

update 
  
 IQ10, Qualified for ADSL over fiber-MX 
  
 IQ11, Qualified for ADSL over fiber-AX 
  

P, C, Speed Code, Date Planned for service on Copper 
  

P, F, Date Planned for Service on Fiber 
 
Note:  A, F denotes end-user is in an ALL-FIBER neighborhood, also called IFITL.   
BellSouth provides broadband to these customers via PC DATA, which is an Ethernet-based 
architecture.  D/CLECs should treat telephone numbers that return A, F in LQS as 
unqualified. 
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4.13 Internal/External Reason Codes (Negative LQS Response) 
 
When a negative LQS response is received, as with a positive response, reason codes will be 
given.  The table below shows these reason codes and includes both positive and negative 
feedback.  The external reason codes are actually error codes that will be explained in Section 
4.12 of this document. 
 

External Reason Codes Internal Reason Codes 
  
Null When paired with certain External Reason 

Codes, such as E2, this code may be null.  
  
E0 – Request ignored – file size limit Same 
  
E1 – Syntax error in phone number Same 
  
E2 – Service  not available  I1: Copper loop with RZ>13 
 I2: Copper loop is loaded 
 I3: Copper loop has Digital Added Main 

Line (DAML) 
 I4: Pair Gain Loop with no Remote 

DSLAM-  
 I5: Taper code is a dead zone 
 I6:  Not Used 
 I7: FN is loaded 
 I9: Terminal CZ > 9 
 I10: Existing service category not 

compatible 
 I11: Phone number is foreign exchange 
 I12: Taper code exceeds distance limit 

 
 I13: NPA-NXX is not found 
 I14:  Not Used 
 I15: PE status not recognized as WKG, CT, 

or PRU 
 I16: No loops found in NPANXX 
 I17: Forced disqualified loop: SOEG 

transmission problem with line  
 I18:  Not Used 
 
This table continues on the next page. 
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External Reason Codes Internal Reason Codes 
E2 (continued)   
 I19: Different Premises Address (DPA) 
  
 I25: Forced Disqualification by manual 

override. 
  
 I26: Loop has multi line DAML  
  
 I27: Business line only area- loop is not 

business USOC.   
  
 128: Remote DSLAM is capped 
  
E3 – Currently unqualified. Please try again 
later. 

I1Copper loop with RZ greater than 13 
 

  
 I4: Pair gain loop with no Remote DSLAM 

 
  
 I8: Wire center not DSLAM-equipped 
  
 I12: Taper code exceeds distance limit: <limit> 
  
E4 – Existing service type is incompatible I20: Existing USOC (Universal Service Order 

Code) is incompatible 
  
E5 – Not used Same 
  
E6 – No loop information -refresh 
automatically requested. 

Same 

  
E7 – Not used Same 
  
EA1 – Syntax error in Address Key I21: Syntax error in address key 
  
EA2 – Address Key not valid I22:  Address Key not found in LQS database 
  
EA3 – Address currently unqualified.  Please 
try again later. 

I23:  All loops present and address not CO 
qualified and not supported by remote DSLAM 
 
I24:  All loops disqualified at this location 
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4.14 Not Qualified Response Results  
This section explains the reason codes (internal and external) that may be received indicating 
why the loop cannot be qualified.   
 
E1 – “Syntax error in phone number”  
 

• Invalid telephone number format or character found 
 
E2 - “Service not available”  
 
  Internal Codes I1, I9 I12, and I14  

 
− The loop is too long to support ADSL  

  
− I1: overall loop resistance > 1300  

  
− I9: Carrier Zone > 900  

 
− I12: Taper code exceeds distance limit <Max F1 Distance + Max Fn 

Distance>. Limit = <Taper Distance Limit>.  Example: 
13.27+6.1=19.37).   

 
In this example: F1 length is 13.27 KF; maximum length of distribution 
pair is 6.1 KF; Total is 19.37 KF. This exceeds the 18.0KF maximum.  

 
− I14: Taper code Max F1 Distance = 0.0 KF; in taper code file, if cross-

box is entirely PG fed, shows 0.0 KF distance; would only qualify based 
on remote solution. 

 
 Internal Codes I2 and I7 
  

− The loop contains one or more load coils.  
  
 Internal Codes I3 and I6  
 

− The phone number is on a DAML.  
 
 Internal Code I5  

 
− The customer falls within a known “dead” zone, an area flagged by 

maintenance personnel where ADSL is known not to work.  
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Chapter 4.0:  Ordering Guidelines (continued) 
 
 Internal Code I10  

 
− The line is not POTS or plain Centrex.  

 
− There may be existing ADSL or Line Sharing on the line 

  
 Internal Code I11  

 
− The phone number is a Foreign Exchange/Foreign Central Office 

(FX/FCO) line.  
 
 
 Internal Code I13 and I16 

 
− The NPA-NXX belongs to one customer (e.g. a University) and all 

numbers in the range are PBX (Private Branch Exchange) DID (Direct 
Inward Dialing) or Primary Rate ISDN numbers  

 
OR 

 
− The NPA-NXX belongs to a CLEC  

 
OR 

 
− The NPA/NXX is a BellSouth NPA/NXX but currently has no working 

loops 
 
 Internal Code I15 

 
− The Pair Evaluation (PE) status of the loop must be WKG (Working), CT 

(Connect Through) or PRU (Pair Restriction Usage) status or the TN  
(Telephone Number) is incompatible for PE reasons. 

 
 Internal Code I17 
 

− Outside plant engineering has determined that this TN is incompatible 
with ADSL services even though it originally qualified; future 
qualification is prevented. 
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 Internal Code I18 

 
− Custom filter established for designated wire centers (This is a filter 

feature implemented two years ago.  It has never been used.) 
 

 Internal Code I19 
 

− TN appears in multiple locations, either in same wire center or different 
wire centers; incompatible with ADSL 

 
 Internal Code I20 
 
    Existing USOC is incompatible 
  
 Internal Code I21 
 
  Syntax error in address key 
 
 Internal Code I22 
 
   Address Key not found in LQS database 
 
 Internal Code I23 
 

All loops present and address not CO qualified and not supported by remote 
DSLAM 
 

 Internal Code I24 
 
  All loops disqualified at this location 

 
Internal Code I25  
   

Forced disqualification by manual override. 
 
Internal Code I26  
 

Loop has multi line DAML 
Internal Code I27 
 

Business Line only area - loop in not business USOC.   
 

 E3 -  “Currently unqualified. Please try again later”  
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 Internal Code I4  
 

− The loop is behind a digital loop carrier system and no Remote DSLAM 
is available.  

 
Internal Code I8  
 

− This central office is not equipped with a BellSouth DSLAM.  
 
E4 – “Existing Service type is Incompatible” 
 

− Service generally available to this location, but loop is not a BellSouth-
provided exchange access line as required by the tariff to provision 
ADSL. 

 
E6 - “No Loop information – refresh automatically requested”  

  
 When the loop data does not exist in LQS, external code E6 is given and it is repeated in 

the internal code field. 
 

− The phone number is on an ISDN line.  
 

− The phone number is newly installed and not yet in LQS.  
 

− The phone number is a DID behind a PBX.  
 

− The phone number is served via Primary Rate ISDN.  
 

− The phone number may belong to a facilities-based CLEC and is 
outside of BellSouth’s network.  

 
Note: LQS triggers a forced refresh on an E6 response.  If this is a valid BellSouth number,  

    the number will be recognized in LQS within 48 hours.  It may or may not qualify at that 
    point based upon other existing LQS qualification criteria 

 
 
4.15 Logic Sequence of LQS 1

LQS will stop the search and logic routines when the first error condition appears.  That error 
will be reported. It does not continue and find all error codes prior to stopping the search.   
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There are two main search sequences, one for telephone numbers (TN) and one for address 
keys (AK).   
 
4.15.1 Qualifying a Telephone Number (TN) 

When qualifying a TN, LQS searches for the following conditions, and stops searching when 
the first condition is true.   
 

Error Item Output Upon Error Identification 
Syntax Error in TN E1 
Loop not found E6 
Loop not found (NPA-NNX not found) E2 

I13 
Loop not found (NPA-NNX empty) E2 

I16 
Loop has line problem 
(Transmission error) 

E2 
I17 

Loop is DPA E2 
I19 

Loop is forced to disqualify E2 
I25 

Loop is Non-Locally switched 
(Foreign Exchange) 

E2 
I11 

Living Unit Taper Code is in Dead Zone E2 
I5 

Living Unit is PCData capable by LFACS 
update (and not UNE-P) 

IQ8 

Living Unit is PCData capable by CMS update 
(and not UNE-P) 

IQ5 

Loop Taper Code is in Dead Zone E2 
I5 

Loop has Unknown Pair Evaluation (PE) E2 
I15 

Loop is PBX E2 
I10 

Loop Service Category not ADSL capable E2 
I10 

Loop has Multi-Line DAML E2 
I26 
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After LQS has searched the conditions listed above and if none are true, then if the loop has a 
“remote” solution, the following table is checked: 
 

Error Item Output Upon Error Identification 
  
Loop is FN loaded E2 

I7 
Loop has Remote DAML E2 

I6 
Loop Carrier Zone > 900Ω E2 

I9 
Loop in Business Only area 
(and does not have business USOC) 

E2 
I27 

Loop already has ADSL service (and not UNE-
P) 

IQ23 

Cross Box or Distribution Terminal is CAPPED E3 
I28 

Wire Center does not have DSL capability E3 
Loop is UNE-P E4 

I20 
  
 
If the loop does not have a “remote” solution, then this table is checked to see if the loop is 
“copper qualified”: 
 

Error Item Output Upon Error Identification 
  
Loop is FN loaded E2 

I7 
Loop has Remote DAML E2 

I6 
Loop RZ > 13 E3 

I1 
Taper Code length too long E3 

I12 
Pair Gain loop with no Remote DSLAM I4 
Copper Loop is loaded I2 
  
Wire  Center does not have DSL capability E3 
Loop is UNE-P E4 

I20 
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4.15.2 Qualifying an Address Key (AK) 

When qualifying an AK, LQS first checks the living unit for the AK: 
 

Error Item Output Upon Error Identification 
  
Syntax Error in AK AE1 

I21 
Living Unit not found AE2 

I22 
Living Unit Taper Code is in Dead Zone E2 

I5 
Living Unit is PCData capable 
(by LFACS update) 

IQ8 

Living Unit is PCData capable  
(by CMS update) 

IQ5 

 
 
If the Living Unit does not qualify, then LQS checks the loops associated with the Living Unit 
(up to a Maximum of 100 loops).  If it finds an “available” loop, it returns that result.  If it finds 
“planned” loops, it returns the earliest “planned” loop, else the AK does not qualify. 
 
For each of the loops in the Living Unit, LQS searches the following tables and stops 
searching when the first condition is true (note, this is NOT the same sequence as qualifying 
an individual telephone number): 
 

Error Item Output Upon Error Identification 
  
Loop Taper Code is in Dead Zone E2 

I5 
Loop has MultiLine DAML E2 

I26 
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After LQS has searched the conditions listed above and if none are true, then if the loop has a 
“remote” solution, the following table is checked: 
 

Error Item Output Upon Error Identification 
  
Loop is FN loaded E2 

I7 
Loop has Remote DAML E2 

I6 
Loop Carrier Zone > 900Ω E2 

I9 
  
Loop in Business Only area 
(and does not have business USOC) 

E2 
I27 

Cross Box or Distribution Terminal is 
CAPPED 

E3 
I28 

Wire Center does not have DSL capability E3 
 
If the loop does not have a “remote” solution, then this table is checked to see if the loop is 
“copper qualified”: 
 

Error Item Output Upon Error Identification 
  
Loop is FN loaded E2 

I7 
Loop has Remote DAML E2 

I6 
Loop RZ > 13 E3 

I1 
Taper Code length too long E3 

I12 
Pair Gain loop with no Remote DSLAM I4 
Copper Loop is loaded I2 
Wire Center does not have DSL capability E3 
 
Since LQS performs the check for the presence of a BellSouth DSLAM, if LQS shows   the 
error, “The Central Office” is not equipped with ADSL”, the loop can be assumed but not 
guaranteed to be qualified. 
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If LQS finds the existence of a BellSouth Remote Solution, most of the data about the loop is 
ignored except for F2 qualifications.  Therefore, if LQS shows the response “Qualified Through 
Remote Solution”, only the F2 portion of the loop can be assumed to be qualified.  Typically, 
these serving arrangements will not have copper pairs available.  A Manual Loop Makeup 
needs to be requested in these situations to determine if any copper pairs exist at the remote 
terminal site.  

Numbers not having an LFACS cable pair assignment, such as the phone in a Collocation 
space, will not show up in LQS.  

The Transcript: 
 
To view the Transcript, select the "Utilities->Transcript" menu option.  This will open the  
Transcript window. 
 

 
 

The Transcript maintains a record of the TN and Address Key qualifications.  It does not need 
to be open to record the results.  There is a limit, however, on how much information the 
Transcript can hold.  If this limit is reached, the oldest qualification results will be lost.  
 
To save the information either copy the contents of the Transcript to the clipboard or turn on 
the Log Transcript option.  
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Results from the Transcript may be copied to the clipboard by selecting "Edit->Select All" and 
then "Edit->Copy".  Portions of the Transcript may be copied to the clipboard by highlighting 
the text in the Transcript and selecting "Edit->Copy".  
 
NOTE:  As a shortcut, if "Edit->Copy" is selected and no text is highlighted in the Transcript, 
the whole contents of the Transcript will be copied to the clipboard.  
 
The Messages view at the bottom of the Transcript is used to show any messages from the 
Bulk File Import.  
   
4.16 Log Transcript: 
The Log Transcript feature copies the contents of the Transcript to an external file and adds 
any new results to the file as they are displayed.  The system "logs" any results report to the 
Transcript to the selected file.  This is especially useful for processing a Bulk List (see Bulk 
Submit) and recording the results.  
 
From the main window, select the "File->Log Transcript" option.  A file dialog will appear:  
 

 
 

Select the file to use as the log.  A file may be reused but it will be overwritten. A warning will 
be provided and the file may be changed before it does so.  Once a file name has been 
entered, the contents of the Transcript will be copied to that file.  This is a safety feature in 
case "Log Transcript" has not been turned on prior to qualifying TNs.  
 
Now, any results displayed in the Transcript will also be appended to the log file.  The file will 
be closed when the LQS GUI closes.  
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4.17 Copy to the Clipboard 
The LQS GUI allows text to be copied to the system clipboard.  Different views provide this 
functionality in different ways. All text views support the Ctrl-C keyboard shortcut.  Any text 
that is highlighted when Ctrl-C is depressed will be copied to the clipboard.  In some cases, a 
'beep' may be heard.  The beep can be ignored.  
 
Many text views support a context menu.  Depress the Right Mouse Button while over the 
view and a menu will appear.  The menu will contain a "Copy" menu option and may contain a 
"Copy All" menu option.  
 
Text view is displayed when the Results Button is clicked that supports a content menu. The 
Search Results list also supports a context menu.  It will copy the selected address to the 
clipboard as shown below.    
 

 
 

 
4.18 Bulk Submit Utility: 
 
Use the Bulk Submit utility to process a list of numbers simultaneously.  From the main 
window, select "Utilities->Submit Bulk File" on the menu bar.  A file chooser will request the 
location of a file containing the telephone numbers (one per line).  A progress indicator will 
display after the records are being processed.  The import may be cancelled at any time by 
depressing the "Cancel" button on the progress dialog as shown on the next example:  
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A progress indicator will display after the records are being processed.  The import may be 
cancelled at any time by depressing the “Cancel” button on the progress dialog. 
 
 

 
 

 
When the import is complete or canceled, the Transcript window will be opened showing the 
results. It is recommended that the Log Transcript be turned on prior to doing a bulk submit to 
save the qualification results to a file.    
 
4.18 Quitting: 
 
To quit the LQSGUI, select "File->Exit" from the main window.  A warning will not be given that 
the application is about to close.  The application will be logged off the server and the log file 
will be closed (if open). 
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Chapter 5.0: Frequently Asked Questions (FAQ’s) Regarding 
Addressed Based Qualification  
 
Since address-based DSL loop qualification was made available on 1/17/03, here are some of 
the most commonly asked questions. 
   

Q.  If I get a qualified response on an address-based qualification, does this mean 
that ANY telephone number at that address qualifies for DSL? 

 
Answer:  No.  Address qualification indicates that an address is DSL “capable” and 
should always be treated as a “Conditional Qualification.”  It is conditional in that final 
DSL qualification is dependent on the end-user having DSL compatible voice service 
at the address.  Existing loops at a DSL capable address may not be qualified due to 
service incompatibilities. The only reliable way to determine the DSL capability of a 
specific loop is with a telephone-number-based loop qualification.  A subsequent 
telephone-number based qualification should always be performed on the actual 
telephone number that the DSL is to be ordered on.   Here are some examples why: 

 
Example 1:  If there are 5 working telephone numbers at an address and only one of 
those telephone numbers is DSL compatible, LQS will return a “qualified” response on 
an address-based qualification, but DSL cannot be ordered on the 4 incompatible 
telephone numbers that may be ISDN, DID trunks, Unbundled Network Elements 
(UNEs), etc.  A subsequent telephone number-based qualification will indicate if any of 
the numbers truly do qualify. 

 
Example 2:  If an address can be served by DSL, but there are no DSL compatible 
numbers at an address, LQS will still provide a qualified response to indicate that the 
“address” is DSL capable.  However, the end-user would need to order a DSL 
compatible voice line before DSL can be ordered on a given telephone number. 
 

 
Q. Is LQS able to determine DSL qualification of an address if there are currently no 

working numbers at an address? 
 

Answer:  Yes. As long as the address exists in BellSouth’s engineering records, LQS 
can map the address back to its associated serving facilities to determine DSL 
capability. 
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Chapter 5.0: Frequently Asked Questions (FAQ’s) Regarding Addressed Based 
Qualification (continued) 

 
Q. When should I perform an address-based qualification in LQS? 

 
Answer:  Address-based qualification should be performed: 
• To determine if DSL can be provided at an address if the end-user ordered a DSL 

compatible voice service at that address. 
• To validate qualification of a telephone number.  If an end-user moves a DSL 

qualified telephone number from an old address to a new address, LQS may 
continue to return a positive qualification of that telephone number based on the 
“old” loop information for 1 to 30 days.   A subsequent address-based qualification 
check will help confirm that the number will qualify at the new address - as long as 
there were no changes made to the voice service that would make it incompatible 
with DSL. 

 
Q.   When I perform an address-based query in LQS, I find it difficult to get an exact 

address match.  Are there any tips when performing an address qualification? 
 

Answer:  When performing an address search in LQS, try the following to narrow the 
list of possible matches: 
• Since “City” or “Zip Code” is required (and not both), populate the zip code in your 

search and leave the “City” field blank. This will minimize the number of invalid 
choices.  Populate city only if you do not know the zip. 

• Use abbreviations on “directionals” preceding the main address.  As an example, 
type “ 100 N Main St” instead of “100 North Main St”. 

• Make sure the correct suffix (e.g. St, Dr, Rd, Av, Blvd, Hwy, Ct, Cir, etc) is used.  
 

 
Q.  I cannot get an exact match on an address search.  Why? 
 

Answer:  Some possible reasons include: 
• The address is so new that it does not appear in BellSouth’s engineering records 

yet.  DSL capability is indeterminate at this time for this address. 
• The local municipality has changed the end-user street address and is not reflected 

in BellSouth’s engineering records. 
• The customer address is in a rural route area with a non-standard address. 

 
Q. I get an exact match on the address, but LQS cannot provide an Address Key.  
 
      Answer:  LQS obtains address information from the BellSouth Street Address Guide 

(SAG) database.  Address Keys are derived from an internal "living unit" identifier 
received from SAG.  The address selected does not currently contain a “living unit” 
identifier, and address-based DSL qualification cannot be determined at this time. 
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ACRONYMS 
 
ADSL    Asymmetric Digital Subscriber Line 
 
API     Application Protocol Interface 
 
BBR-LO   BellSouth Business Rules – Local Ordering 
 
CC    Company Code 
 
CF    Connected Facility 
 
CLEC    Competitive Local Exchange Carrier 
 
CLLI    Common Language Location Identifier 
 
CO    Central Office 
 
CT    Connect Through 
 
DAML    Digital Added Main Line 
 
DFITL    Data Over Fiber In The Loop 
 
DID    Direct Inward Dialing 
 
DLC    Digital Loop Carrier 
 
DLEC    Data Local Exchange Carrier 
 
DPA    Different Premises Address 
 
DSLAM   Digital Subscriber Line Access Multiplexer 
 
FCC    Federal Communications Commission 
 
FCO    Foreign Central Office 
 
FRN    Facility Reservation Number 
 
FX    Foreign Exchange 
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Chapter 6.0: ACRONYMS (continued) 
 
GUI    Graphical User Interface 
 
ID    Identification 
 
IFITL    Integrated Fiber In The Loop 
 
ISDN    Integrated Services Digital Network 
 
ISP    Internet Service Provider 
 
LCM    Local Contract Manager 
 
LEAD    Loop Engineering Assignment Data 
 
LFACS    Loop Facilities Assignment and Control System 
 
LMU    Loop Makeup 
 
LMUSI    Loop Makeup Service Inquiry 
 
LOA    Letter of Authorization 
 
LSM    Local Support Manager 
 
LQS    Loop Qualification System 
 
LQSGUI   Loop Qualification System Graphical User Interface  
 
LSP    Local Service Provider 
 
LUID    Living Unit Identification 
 
NSP    Network Service Provider 
 
OEC    Outside Plant Equivalence Code 
 
PBX    Private Branch Exchange 
 
PC    Personal Computer 
 
PCF    Partially Connected Facility 
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Chapter 6.0: ACRONYMS (continued) 
 
PE    Pair Evaluation 
 
POTS    Plain Old Telephone Service 
 
PRU    Pair Restriction Usage 
 
RT    Remote Terminal 
 
SI    Service Inquiry 
 
TN    Telephone Number 
 
USOC    Universal Service Order Code 
 
WKG    Working 
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